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Preface

This document is a formal contract deliverable. It requires Government review and approval
within 45 business days. Changes to this document will be made by document change notice
(DCN) or by complete revision.

Any questions should be addressed to:

Data Management Office
The EED Project Office
Raytheon Company

5700 Rivertech Court
Riverdale, Maryland 20737
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Abstract

This is Volume 4 of a series of lessons containing the training material for the EED Contract.
This lesson provides a detailed description of the process required for data distribution.

Keywords: training, instructional design, course objective, distribution, data distribution,
Product Distribution System, Order Management Subsystem, OMS, Order Manager, Release 8.3
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Introduction

Identification

Training Material Volume 4 is part of Contract Data Requirements List (CDRL) Item 23, which
is a required deliverable under the EED Contract (NNG10HP02C).

Scope

Training Material Volume 4 describes the process and procedures for data distribution. This
lesson is designed to provide the operations staff with sufficient knowledge and information to
satisfy all lesson objectives.

Purpose

The purpose of this Student Guide is to provide a detailed course of instruction that forms the
basis for understanding data distribution. Lesson objectives are developed and will be used to
guide the flow of instruction for this lesson. The lesson objectives will serve as the basis for
verifying that all lesson topics are contained within slide presentation material.

Status and Schedule

This lesson module provides detailed information about training for the current baseline of the
system. Revisions are submitted as needed.

Organization
This document is organized as follows:

Introduction: The Introduction presents the document identification, scope,
purpose, and organization.

Related Documentation: Related Documentation identifies parent, applicable and
information documents associated with this document.

Student Guide: The Student Guide identifies the core elements of this lesson. All

Lesson Objectives and associated topics are included. The Student
Guide consists of a Slide Presentation is reserved for all slides used
by the instructor during the presentation of this lesson.
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Related Documentation

Parent Documents

The parent documents are the documents from which the EED Training Material’s scope and
content are derived.

Statement of Work for EOSDIS Evolution and Development Contract

423-CDRD-001 Contract Data Requirements Document for EED Task 02 ECS SDPS
Maintenance

Applicable Documents

The following documents are referenced within this EED Training Material, or are directly
applicable, or contain policies or other directive matters that are binding upon the content of this
document:

423-46-01 Goddard Space Flight Center, Functional and Performance
Requirements Specification for the Earth Observing System Data and
Information System (EOSDIS) Core System (ECS) Science Data
Processing System (EED F&PRS)

Information Documents

Information Documents Referenced

The following documents are referenced herein and amplify or clarify the information presented
in this document. These documents are not binding on the content of the EED Training Material.

609-EED-001, Rev. 03 Release 8.3 Operations Tools Manual for the EED Contract
611-EED-001, Rev. 03 Release 8.3 Mission Operation Procedures for the EED Contract

Information Documents Not Referenced

The following documents, although not referenced herein and/or not directly applicable, do
amplify or clarify the information presented in this document. These documents are not binding
on the content of the EED Training Material.

305-EED-001, Rev. 03 Release 8.3 Segment/Design Specifications for the EED Project.

311-EED-001, Rev. 03 Release 8.3 INGEST (INS) Database Design and Schema
Specifications for the EED Project.

311-EED-002, Rev. 03 Release 8.3 Order Manager Database Design and Database
Schema Specifications for the EED Project.

311-EED-003, Rev. 03 Release 8.3 Spatial Subscription Server (SSS) Database Design
and Schema Specifications for the EED Project.

311-EED-005, Rev. 03 Release 8.3 Archive Inventory Management (AIM) Database

Design and Schema Specifications for the EED Project.
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Data Distribution Overview

Lesson Overview

This lesson will provide you with the complete process by which the Distributed Active Archive
Center (DAAC) personnel perform data distribution, including order management using the
Order Manager (OM) graphical user interface (GUI). The processes described in the lesson
apply to Distribution Technicians. The procedures involved in OM GUI operation include such
tasks as launching the OM GUI, responding to an open intervention, viewing distribution request
information, viewing a completed intervention, and checking OM queue status.

Lesson Objectives

Overall Objective - The overall objective of the Data Distribution lesson is for personnel
involved in maintenance and operation of the Earth Observing System Data and Information
System (EOSDIS) Core System (ECS) to develop proficiency in the procedures that apply to
data distribution.

Condition - The student will be given oral or written information and requirements for
performing data distribution activities, access to the Data Server Subsystem, access to the OM
GUI, a copy of 609-EED-001 Revision 03, Release 8.3 Operations Tools Manual for the EED
Contract, and a copy of 611-EED-001 Revision 03, Release 8.3 Mission Operation Procedures
for the EED Contract.

Standard - The student will perform data distribution activities in accordance with the
prescribed procedures without error.

Specific Objective 1 - The student will describe the general functions and processes associated
with data distribution.

Condition - The student will be given written or oral questions concerning the general functions
and processes associated with data distribution.

Standard - The student will state without error the general functions and processes associated
with data distribution in accordance with the lesson content and the applicable procedures.

Specific Objective 2 - The student will perform the steps involved in logging in to system hosts.

Condition - The student will be given a statement of the requirements for logging in to system
hosts, access to the Data Server Subsystem (using a workstation), a copy of 609-EED-001
Revision 03, Release 8.3 Operations Tools Manual for the EED Contract, and a copy of 611-
EED-001 Revision 03, Release 8.3 Mission Operation Procedures for the EED Contract.

Standard - In accordance with the lesson content, the applicable procedure, and the statement of
requirements the student will access the command shell, set the DISPLAY environmental
variable, and log in to the specified host using secure shell and the specified user ID.
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Specific Objective 3 - The student will perform the steps involved in monitoring/controlling
data distribution requests, including configuring data distribution polling, filtering data
distribution requests, changing the priority of distribution requests, suspending/resuming
distribution requests, and canceling distribution requests.

Condition - The student will be given a statement of the requirements for monitoring/controlling
data distribution requests, access to the previously launched Data Distribution Operator GUI in
the Data Server Subsystem (using a workstation), a copy of 609-EED-001 Revision 03, Release
8.3 Operations Tools Manual for the EED Contract, and a copy of 611-EED-001 Revision 03,
Release 8.3 Mission Operation Procedures for the EED Contract.

Standard - In accordance with the lesson content, the applicable procedure, and the statement of
requirements the student will monitor/control data distribution requests (including configuring
data distribution polling, filtering requests, and changing the status of distribution requests as
directed) and respond to questions concerning the current status of distribution requests.

Specific Objective 4 - The student will perform the steps involved in launching the Order
Manager (OM) GUI.

Condition - The student will be given a statement of the requirements for launching the OM
GUI, access to system hosts (using a workstation), a copy of 609-EED-001 Revision 03, Release
8.3 Operations Tools Manual for the EED Contract, and a copy of 611-EED-001 Revision 03,
Release 8.3 Mission Operation Procedures for the EED Contract.

Standard - In accordance with the lesson content, the applicable procedure, and the statement of
requirements the student will log in to an appropriate host using secure shell, enter the command
to start the Netscape browser, enter the URL to access the OM GUI in the specified mode, and
enter the appropriate user name and password in the security dialogue box.

Specific Objective 5 - The student will perform the steps involved in viewing open intervention
information on the OM GUI.

Condition - The student will be given a statement of the requirements for viewing open
intervention information on the OM GUI, access to the previously launched OM GUI (using a
workstation), a copy of 609-EED-001 Revision 03, Release 8.3 Operations Tools Manual for the
EED Contract, and a copy of 611-EED-001 Revision 03, Release 8.3 Mission Operation
Procedures for the EED Contract.

Standard - In accordance with the lesson content, the applicable procedure, and the statement of
requirements the student will use the OM GUI to select the Open Interventions link and the Open
Intervention Detail page for a specific open intervention and will respond to questions
concerning the intervention.

Specific Objective 6 - The student will perform the steps involved in responding to an open
intervention using the OM GUI.

Condition - The student will be given a statement of the requirements for responding to an open
intervention using the OM GUI, access to the previously launched OM GUI (using a
workstation), a copy of 609-EED-001 Revision 03, Release 8.3 Operations Tools Manual for the
EED Contract, and a copy of 611-EED-001 Revision 03, Release 8.3 Mission Operation
Procedures for the EED Contract.
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Standard - In accordance with the lesson content, the applicable procedure, and the statement of
requirements the student will use the OM GUI to select the Open Interventions link, select the
specified intervention, assign self to work on the intervention, select the appropriate attributes for
the intervention, apply the attributes, and confirm the disposition of the intervention.

Specific Objective 7 - The student will perform the steps involved in monitoring and controlling
distribution requests on the OM GUI.

Condition - The student will be given a statement of the requirements for monitoring and
controlling distribution request information on the OM GUI, access to the previously launched
OM GUI (using a workstation), a copy of 609-EED-001 Revision 03, Release 8.3 Operations
Tools Manual for the EED Contract, and a copy of 611-EED-001 Revision 03, Release 8.3
Mission Operation Procedures for the EED Contract.

Standard - In accordance with the lesson content, the applicable procedure, and the statement of
requirements the student will use the OM GUI to select the Distribution Requests link and
respond to questions concerning distribution request status, change the priority of a distribution
request (if applicable), suspend, resume, cancel, resubmit, or stop a distribution request (if
applicable), view open intervention information (if applicable), edit ftp push parameters (if
applicable), view operator alerts (if applicable), view to staging requests (if applicable), and/or
view ftppush distribution requests (if applicable).

Specific Objective 8 - The student will perform the steps involved in changing the priority of a
distribution request using the OM GUI.

Condition - The student will be given a statement of the requirements for changing the priority
of a distribution request using the OM GUI, access to the previously launched OM GUI (using a
workstation), a copy of 609-EED-001 Revision 03, Release 8.3 Operations Tools Manual for the
EED Contract, and a copy of 611-EED-001 Revision 03, Release 8.3 Mission Operation
Procedures for the EED Contract.

Standard - In accordance with the lesson content, the applicable procedure, and the statement of
requirements the student will use the OM GUI to select the priority from the option button in the
Priority column of the row associated with the specified request and apply the selected priority.

Specific Objective 9 - The student will perform the steps involved in suspending, resuming,
canceling, resubmitting, or stopping a distribution request using the OM GUI.

Condition - The student will be given a statement of the requirements for suspending, resuming,
canceling, resubmitting, or stopping a distribution request using the OM GUI, access to the
previously launched OM GUI (using a workstation), a copy of 609-EED-001 Revision 03,
Release 8.3 Operations Tools Manual for the EED Contract, and a copy of 611-EED-001
Revision 03, Release 8.3 Mission Operation Procedures for the EED Contract.

Standard - In accordance with the lesson content, the applicable procedure, and the statement of
requirements the student will use the OM GUI to click on the appropriate button in the Action
column of the row associated with the request, respond to the applicable dialogue box(es),
initiate an intervention to resubmit the specified request (if resubmitting a request), specify the
appropriate attributes of the intervention as specified in the requirements (if resubmitting a
request), and confirm the disposition of the intervention (if resubmitting a request).parameters.
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Specific Objective 10 - The student will perform the steps involved in viewing operator alerts on
the OM GUI.

Condition - The student will be given a statement of the requirements for viewing operator alerts
on the OM GUI, access to the previously launched OM GUI (using a workstation), a copy of
609-EED-001 Revision 03, Release 8.3 Operations Tools Manual for the EED Contract, and a
copy of 611-EED-001 Revision 03, Release 8.3 Mission Operation Procedures for the EED
Contract.

Standard - In accordance with the lesson content, the applicable procedure, and the statement of
requirements the student will use the OM GUI to select the Operator Alerts link, respond to
questions concerning specific alerts as displayed on the Operator Alerts page, select the
corresponding details link in the Alert Info column, and respond to questions concerning alert
details as displayed on the detail page.

Specific Objective 11 - The student will perform the steps involved in viewing a completed
operator action or intervention using the OM GUI.

Condition - The student will be given a statement of the requirements for viewing a completed
operator action or intervention using the OM GUI, access to the previously launched OM GUI
(using a workstation), a copy of 609-EED-001 Revision 03, Release 8.3 Operations Tools
Manual for the EED Contract, and a copy of 611-EED-001 Revision 03, Release 8.3 Mission
Operation Procedures for the EED Contract.

Standard - In accordance with the lesson content, the applicable procedure, and the statement of
requirements the student will use the OM GUI to select the Request Management link, select the
Completed Operator Actions & Interventions link, and respond to questions concerning a
specified completed action or intervention as displayed on the Completed Operator Actions and
Interventions page.

Specific Objective 12 - The student will perform the steps involved in viewing and responding
to suspended ftp push distribution destinations using the OM GUIL.

Condition - The student will be given a statement of the requirements for viewing and
responding to suspended ftp push distribution destinations using the OM GUI, access to the
previously launched OM GUI (using a workstation), a copy of 609-EED-001 Revision 03,
Release 8.3 Operations Tools Manual for the EED Contract, and a copy of 611-EED-001
Revision 03, Release 8.3 Mission Operation Procedures for the EED Contract.

Standard - In accordance with the lesson content, the applicable procedure, and the statement of
requirements the student will use the OM GUI to select the FtpPush Monitor link, select the
Suspended Destinations link, respond to questions concerning the information displayed on the
Suspended Destinations page, select the Resume button to resume a suspended destination, either
enter the destination name (for a destination to be suspended) in the Destination Name textbox or
type the host name in the FTP Node textbox, and select the Suspend button to suspend an active
destination.

Specific Objective 13 - The student will perform the steps involved in checking and modifying
OM queue status using the OM GUI.

Condition - The student will be given a statement of the requirements for checking and
modifying OM queue status using the OM GUI, access to the previously launched OM GUI
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(using a workstation), a copy of 609-EED-001 Revision 03, Release 8.3 Operations Tools
Manual for the EED Contract, and a copy of 611-EED-001 Revision 03, Release 8.3 Mission
Operation Procedures for the EED Contract.

Standard - In accordance with the lesson content, the applicable procedure, and the statement of
requirements the student will use the OM GUI to select the OM Status Pages link, select the OM
Queue Status link, respond to questions concerning OM queue status, select the appropriate state
from the correct Change State option button as directed, and apply the state change(s).

Specific Objective 14 - The student will perform the steps involved in checking staging status
using the OM GUI.

Condition - The student will be given a statement of the requirements for checking staging
status, access to the previously launched OM GUI (using a workstation), a copy of 609-EED-001
Revision 03 Release 8.3 Mission Operation Procedures for the EED Contract.

Standard - In accordance with the lesson content, the applicable procedure, and the statement of
requirements the student will use the OM GUI to select the OM Status Pages link, select the
Media Type link or FTP Push Destination link as directed, and respond to questions concerning
staging status as displayed on the staging status pages.

Specific Objective 15 - The student will perform the steps involved in checking and modifying
OM configuration parameters.

Condition - The student will be given a statement of the requirements for checking and
modifying OM configuration parameters, access to the previously launched OM GUI (using a
workstation), a copy of 609-EED-001 Revision 03, Release 8.3 Operations Tools Manual for the
EED Contract, and a copy of 611-EED-001 Revision 03, Release 8.3 Mission Operation
Procedures for the EED Contract.

Standard - In accordance with the lesson content, the applicable procedure, and the statement of
requirements the student will use the OM GUI to select the OM Configuration link, select the
Aging Parameters, Server/Database, Media or FTP Push Policy link as directed, respond to
questions concerning configuration parameters as displayed on the configuration parameters
pages, enter the new value(s) in the textbox(es) for the relevant parameter(s), and apply the new
value(s).

Specific Objective 16 - The student will perform the steps involved in adding a destination to
the frequently used destinations list.

Condition - The student will be given a statement of the requirements for adding a destination to
the frequently used destinations list, access to the previously launched OM GUI (using a
workstation), a copy of 609-EED-001 Revision 03, Release 8.3 Operations Tools Manual for the
EED Contract, and a copy of 611-EED-001 Revision 03, Release 8.3 Mission Operation
Procedures for the EED Contract.

Standard - In accordance with the lesson content, the applicable procedure, and the statement of
requirements the student will use the OM GUI to select the OM Configuration link, select the
FTP Push Policy link, select the Add a Destination button, enter value(s) in the textbox(es) for
the relevant attribute(s)/parameter(s) as directed, select the retry mode from the option button as
directed, enter the applicable text in the Notes textbox as directed, apply the values entered for
the new destination, and confirm the new destination.
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Specific Objective 17 - The student will perform the steps involved in viewing the OM GUI log.

Condition - The student will be given a statement of the requirements for viewing the OM GUI
log, access to the previously launched OM GUI (using a workstation), a copy of 609-EED-001
Revision 03, Release 8.3 Operations Tools Manual for the EED Contract, and a copy of 611-
EED-001 Revision 03, Release 8.3 Mission Operation Procedures for the EED Contract.

Standard - In accordance with the lesson content, the applicable procedure, and the statement of
requirements the student will use the OM GUI to select the Logs link, select the OM GUI Log
Viewer link, enter the appropriate number of lines to be displayed (as directed), initiate viewing
of the log, and respond to questions concerning entries in the OM GUI log.

Specific Objective 18 - The student will perform the steps involved in viewing and adding Data
Access Services Configuration on the OM GUI.

Condition - The student will be given a statement of the requirements to view and add a Data
Access Service on the OM GUI, access to the previously launched OM GUI (using a
workstation), a copy of 609-EED-001 Revision 03, Release 8.3 Operations Tools Manual for the
EED Contract, and a copy of 611-EED-001 Revision 03, Release 8.3 Mission Operation
Procedures for the EED Contract.

Standard - In accordance with the lesson content, the applicable procedure, and the statement of
requirements the student will use the OM GUI to select the OM Configuration — Data-Access
Processing link and the Data Access Services Configuration page for a specific open intervention
and will respond to questions concerning the intervention.

Specific Objective 19 - The student will perform the steps involved in preparing an input file for
use with the OMS Configuration CI.

Condition - The student will be given a statement of the requirements for preparing an input file
for use with the OMS Configuration CI, access to system hosts (using a workstation), a copy of
609-EED-001 Revision 03, Release 8.3 Operations Tools Manual for the EED Contract, and a
copy of 611-EED-001 Revision 03, Release 8.3 Mission Operation Procedures for the EED
Contract.

Standard - In accordance with the lesson content, the applicable procedure, and the statement of
requirements the student will access a terminal window logged in to the Linux Server host, enter
the path to the “utilities” directory, use text editor commands to create a file that specifies the
relevant values (as directed) to be sent to the OMS.

Importance

This lesson applies to students who will be Distributed Active Archive Center (DAAC)
Distribution Technicians. The lesson will provide them with the knowledge and skills needed
when performing their assigned tasks. Those tasks include the following types of activities:

e Launching the Data Distribution Operator GUI.

e Monitoring/controlling data distribution requests.

e Using the OMS configuration script (OMS Configuration CI)
e Modifying system parameters.
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The lesson describes why and how the activities are performed. Consequently, the students will
become aware of what tasks they will be performing on the job and how to accomplish those
tasks.
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Slide Presentation

Slide Presentation Description

The following slide presentation represents the slides used by the instructor during the conduct of
this lesson.
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Overview of Lesson

U Distribution Concepts
= System Context Diagram

U Order Manager (OM) Subsystem
= Support for External Processors
» Flow Diagram
= OM Server Components

U Order Manager Services
» OM GUI Functionalities

U Order Manager GUI
» System Hosts Login
= OM GUI Home Page
= Operator Security
= Active Tools
» Order Manager (OM) GUI Operations

625-EED-004, Revision 03 2



Distribution Concepts

O Data Distribution is accomplished at the Distributed Active Archive
Centers (DAACS).

0 DAAC Operator manages order distribution requests using a web
browser and performs direct updates to the Order Manager Service

(OMS) Database.
0 The Order Manager Service (OMS) manages all data orders via:

» EWOC [EOSDIS ClearingHOuse (ECHO) Web Service Distribution Language
(WSDL) Ordering Component (OC)].

» Data Pool (DPL) — talks directly to OMS.

» Spatial Subscription Server (NBSRV) — talks directly to OMS; automatic
product request generated based on subscription criteria.

» DataAccess requested processing — allows users to specify ESI processing
options when selecting granules from a collection by use of a Reverb form.
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Distribution Concepts

(cont.)

O OM Server validates all data order requests received into the OM
Subsystem (OMS), then dispatches each validated request to the
appropriate order-fulfillment service.

0 OMS manages distribution of data by two methods:

1 — Electronically (directly distribute data from staged files linked to DPL
storage directory):
— FtpPush and SCP (Secure Copy Protocol).
—  FtpPull.
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Distribution Concepts

System Context Diagram (cont.)
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Order Manager Subsystem

Support for External Processors

0 OMS manages order from Reverb, ECHO and the External Processor
via EWOC.

1 OMS creates links for each ordered public granule in the hidden
DPL and creates links from the FtpPull directory or distribution.

0 OMS Graphical User Interface (GUI) allows managing and
distributing orders directly to the OM database.

O EWOC registers external processing “orders” with OMS.
d EPD registers external processing “outputs” with OMS.

O OMS distributes external processing and DataAccess outputs like
any other data.

1 OMS displays external processing and DataAccess orders.
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Order Manager Subsystem

Support for External Processors (cont.)

0 OMS distributes external processing outputs like any other data
(e.g., Data Access processing outputs):

= OMS displays external processing orders with associated labels.
» DAAC can configure separate DN preamble, FTP Pull expiration.
» Operator actions are disabled until OMS has control; No resubmit.

= Operator can suspend/cancel/stop/resume acceptance of orders for external
processor.

0 Some Support for ASTER On-Demand.:
= No granule identifiers in DN.
» [.REQ)] file is not distributed.
» PDR changes (backwards compatible).

625-EED-004, Revision 03 7



Order Manager Subsystem

Context Diagram for EP Requests
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Order Manager Subsystem

OM Server Components

0 OM Server has two major parts:

1 — Sybase ASE Server:

- COTS SW application handling order management-related interactions with
the Order Management database.

2 — Order manager (OM) GUI:
- Allows viewing and modifications of requests by Operator.
- Permits suspend, resume, cancel, resubmit or modify functions.
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Order Manager Services

OM GUI Functionalities

0 General functions and processes associated with data distribution
operations can be performed as follows:

» Logging into the system.

» Viewing/Responding to Open Interventions

» Viewing/Filtering Completed Operator Actions and Interventions

» Viewing/Filtering Distribution Requests Data

» Filtering Processing Service Requests

» Filtering FtpPush/SCP (or Staging) Requests

» Handling Operator Alerts

» Viewing/Responding to Suspended FTP Push Distribution Destinations
= Viewing Historical Distribution Requests

= Viewing Historical Processing Requests

___________________________________________________________________________________________________________________________________________________________|
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Order Manager Services

OM GUI Functionalities (cont.)

0 General functions and processes associated with data distribution
operations can be performed as follows:

» Viewing Staging Status
» Viewing Data Pool File System Status

» Checking/Modifying Assigned Values of OMS Server and
Database Parameters

= Adding/Deleting User Email Address that will receive ODL Metadata File
= Adding/Deleting User Email Address that will receive Checksum File

___________________________________________________________________________________________________________________________________________________________|
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Order Manager Services

OM GUI Functionalities (cont.)

0 General functions and processes associated with data distribution
operations can be performed as follows:

» Checking/Modifying External Processing and Data Access Services
Configurations

» Viewing/Modifying FtpPush/SCP Policy Configurations
= Viewing Distribution Requests Order Status Pages
= Viewing the OM GUI Log

___________________________________________________________________________________________________________________________________________________________|
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Order Manager GUI

System Hosts Login

O Activating the OM GUI requires a terminal with a host logon to
access arecommended web browser, i.e., Mozilla 5.0+, Netscape
7+, Firefox 3.5+, generic “Mozilla” for Linux or UNIX.

O Procedure: Logging into the System
> Enter URL (http://x5iil01.<DAAC_extension>:<port>).
> Enter Security Login Prompt information.
ssFigure: Prompt dialog box

Prompt

@ Enter username and password for "OMS Bealm® at p2dps01.pyc.ecs.nasa.qoy:22421
User Mame:

I Username

Fassward:

I Password

[ Use Passwaord hanager to remember these values.

oK Cancel |

> Click OK to launch the Order Manager GUI (Home Page).

___________________________________________________________________________________________________________________________________________________________|
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Order Manager GUI

OM GUI Home Page

ssFigure: Order Manager GUI (Home Page)

iy = 5, hitpziN4spl01, hitccom: 22491 - O GUI - DEVD? MODE - Mozilla Firefox
Ny gdar
) o
| GUI Mavination Tool navigagion [ € L ¥| ".'F""m v —_—
Home -'-- ' 3 100 =
| St Ord-r Manager GUI ~—
[#) Dextnation Monitor DR
o
el | Thy Dwc & 15,0143 2007
-!_]Nl rlon D The Crder Manager GUI allows & DAAL operator o completely manage onder
oM GUI Menu and ‘4 [#] o Configuration disinibution requesis from a web Browser and directly update the Order Manager
Submenu Options [+] Heip _ Serice [OMS) Database
rPhyvies-edie-Diisibutlon—1 Thg OMS GUI has sevieal features, sorn of which ase raw 10 the Syriray W ralease
[#] view Order Status Here is & fist of just some of the major functionaities of the OMS GLUI
e 1 Home Page
\ Qltogs =~ =0 2l * Virw Digtribution Requests and agsocisted granules (2 G U1 Main Window)
":Jf";"l"l-r_’fi _______ It + Manage Physical Media Creation
You are logyed in as: Iﬂlﬂl » Suspend, Resume, Cancel, Slop or Resubmit Requests
Operstor Log {rasd) * Fix cormemon prablerns with Requests
it Indicat * Change Reques1 sttibuies, change granules for a request
M NAICAors. Log 0wl * Vi Oparatir Mlirls
. . # Monitor for suspended FTPFPush/Bop destinations and their requests
If in &dmin hode, st ety i * Manage HEG requests
optional Admin |':l“H :Imwluqrn :I'Il'lﬂhnj + Corfigure the OMS datsbase
Tools Menu_and , H you are reew 10 thes GLI Teal free to vis® the Help page, which cortaing complete
hlode WEFI'III'IQ |'l'-l'¢l111ng.- delails on operations scenarnee and other usefl topics.
I"f'w an running in ADBIN
Lrlm-l:han
Left pane — Menu Options Il——l- Right pane — Menu Options Display
Thae Qvciar Maraper GUT (e300 has Doen hnshed for use with Nelscape L2
Yo e corranbly Laang MoZille S 0 (Windows L Windoms WT 51 ensUiS A0 80 1) Geckar2007 8127 Firedp2.0.0 44
i ] i 7
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Order Manager GUI
OM GUI Home Page (cont.)

Order Manager GUI Menu

Navigation Menu Option

U Request Management provide options to manage all validated requests;
provide interventions capabilities; and process subsetting. It also allow
Operators to fix common problems with requests within the OMS GUI.

Submenu Options

=Open Interventions

=Completed Actions &
Interventions

=Distribution Requests [filter]

=Processing Service
Requests [filter]

=FtpPush/SCP
Requests [filter]

=Staging Requests
[filter]

=Operator Alerts

U0 Destination Monitor provide monitoring capability to suspend
distributions and resume them.

=Suspended Destinations

U Archive Data is the repository for all historically distributed and
processed requests.

=Historical Distribution
Requests [filter]

=Historical Processing
Requests [filter]

0 OM Status Page displays summary information of current request
processing states i.e., suspended or active, for each media server or
email.

. _______________________________|
15
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=Staging Status:
—Media Type
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—SCP Destination
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Order Manager GUI

OM GUI Home Page (cont.)

Order Manager GUI Menu

Navigation Menu Options

U OM Configuration allows Operator to configure aging rules for each

and adjust media types attributes — Media Configuration. Provides
checksum validation on OMS distributed files, which allow Users to

priority level — Aging Parameters; to set database and server parameters,
which affect the entire system — Server/Database Configuration; and to set

Submenu Options

=Aging Parameters
=Server/Database
—[All]

—[queue parms], [cleanup
parms], [email parms],

=Media

=Odl Metadata Users
=Checksum Users
=External Processing
=DataAccess Processing

[media parms], [staging
parms], [partition parms],
[misc. parms]

perform validity tests against their granules. =FtpPush/SCP Policy

O Help provide guidelines to using the OMS GUI. *About HelpOnDemand...  =Help

U View Order Status provides a visual display of viewing multiple levels of a

: *OM GUI Order Status
particular order status.

U Logs displays a log viewer — a convenient diagnostic tool that displays all
current activity in the OM GUI. Records of every running page and stored
procedure are recorded in the log file located under « cgi-bin/logs »
directory.

=OM GUI Log Viewer

=Server/Database
Parameters

=FtpPush Policy

8 Admin Tools administers and maintains FC or LC Operator’ s read (r) =Action Pages

and/or read/write (rw) permissions to all fields of every OM GUI pages. "Media Parameters

=Profile Management
=Aging Parameters

___________________________________________________________________________________________________________________________________________________________|
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Order Manager GUI

Operator Security

OM GUI Operator Security Capabilities

Role Capability

=Primary level activities do not limited the ability to configure parameters; view all levels

U Full-Capability (FC) of interventions activities; view and change actions for distribution request lists and
Operator detailed information; monitor and configure OM Server and OM Database parameters;
etc.
U Limited-Capability (LC) =Secondary level activities are limited to the basic functionality of monitoring and
Operator viewing.

O Administrat =sAdministers read and/or read/write permissions to FC and/or LC Operators for the
TS rEner purpose of viewing, monitoring, configuring, and/or maintaining all fields of the OM GUI.

|
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Order Manager GUI

Active Tools

O Active Tools for OM GUI Pages:

= Frame A: Browser “Find in this Page (Ctrl+F)” search tool:

— The browser search menu option features keyword search of the data within the
current screen (page) display.

* Frame B: OM GUI navigation tool:

— Features ability to review previous/next page or to reload current page show on the
OM GUI,

= Frame C: OM GUI AutoRefresh tool:

— The AutoRefresh Control Panel, displayed at bottom of most OM GUI pages, can be
set to automatically reload an active page by designated minutes.

s*Figure: Find (A), Navigation (B) and AutoRefresh (C) Tools

AE Find: | | & ne Fignlaht 2 [ Matgh case
B ’ .
nav'gatlon C first | previous | Showing 1 - 5 of 405 | next | last
Pravious Page - Naxt Paga
H( U ) AutoRefresh Control Panel [ON] |
Refresh screen every |5 v minutes
Reload AutoRefresh: Clon O off |

Current Pagae
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Order Manager GUI

Request Management

d OM GUI - REQUEST MANAGEMENT

» The Operator is provided options to manage, monitor and control
open/completed interventions. Allowing intervention capabilities helps
to ensure eligible requests, from varying order sources, are distributed
or handled appropriately. The action to process subsetting is also
available. Non-fatal errors and warnings related to data space/storage,
ftpPush/SCP destination, and server warnings are functions handled
within the OM GUIL.

» Request Management submenus:

— Open Interventions.

— Completed Actions & Interventions.
— Distribution Requests [filter].

— Processing Service Requests [filter].
— FtpPush/SCP Requests [filter].

— Staging Requests ([filter].

— Operator Alerts.

___________________________________________________________________________________________________________________________________________________________|
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OM GUI

Request Management (cont.)

U Request Management — Open Interventions

= Provides list of all the currently open Operator interventions that require
action. Interventions can be managed using a Change Filter, Bulk Fail
and/or Bulk Submit features on the page.
» Interventions activities performed to:
— Select a different granule to replace an unavailable granule.

— Fail selected granule(s). [NOTE: A permanent action that cannot be canceled
after a confirmed action.]

— Change the attributes ﬁdistribution medium, disable limit checking, update
parameters and [.XML] to [.ODL] format conversion) for a request.

— Attributes changes to update FtﬁPush/S_CP parameters option will edit the existing
(related) FtpPush information when the intervention is closed.

— Change the disposition: Resubmit, Fail, or Partition (divide) a request.
» Failing a granule is a permanent action, if confirmed, cannot be canceled.

= Standard media capability limits for a particular media type (i.e., FtpPush,
FtpPull, SCP) can be override, using the Disable Limit Checking
attributes options.

= The Reset button on pa%e_s, it simply resets the Request Level
Disposition options to their original value.

___________________________________________________________________________________________________________________________________________________________|
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OM GUI

Request Management (cont.)

U Request Management — Open Interventions

= Open Interventions Page has three working parts:
1 — Current Filter (Frame 1) — pre-defined filter criteria.
2 — Options (Frame 2) — features to change filter, bulk fail or bulk submit requests.
3 — Listing (Frame 3) — requested distribution filtered output.

Current Filters Options Listing

Fialds Actions il
Crdar D Changs Filtar Sal
OFail O%ub
Croation Tima: Bulk Fail
satin a OrdariD
* End E
: Neing Requast 1D
Madial Typa Bulk Submit
_ = All Moedia Type
Intervantion Ty pa A Mana
Raquest SEa
Request ID (MD)
Worked By Status
Explanation ARl
Craatad

Acknowladged

Explanation(s)

IntaryTypa
1
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OM GUI

Request Management (cont.)

U Request Management — Open Interventions

* Procedure: Viewing/Responding to Open Interventions
> Click Request Management menu, then click submenu Open Interventions.
Specify the Show <number> rows at a time display: Under Listing, select 20.
Organize/Sort page by creation time, in ascending order: Click Created label.
Display detailed data of order: Click a specified Order ID <number>.
View Open Interventions For Request <ID> details: Click a specified Request ID <number>.

Assign a Worker: Click the assign link and enter <employeelD> in input box, then click the
green-checked button to confirm.

ssFigure: Worker Assignment

v v v v v

work'Ed by:-nn-ww.‘vce.rassr'gned- [assign |jp-ir|cr @ [ﬂ

> Manually Fail Granule: Under Granule List section, Locate Explanation, “Manual fail required”
and click Fail checkbox, then click Submit Actions button.

> Change granule attributes to alter the characterization or features, under Request Attributes
section, click Change Media to arrow and choose new type; click Change Priority to arrow and
select new priority; click Disable limit checking checkbox to disable size limit.

___________________________________________________________________________________________________________________________________________________________|
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OM GUI

Request Management (cont.)

U Request Management — Open Interventions
* Procedure: Viewing/Responding to Open Interventions (cont.)

o Ci . i
ssFigure: Worker Assignment A
Request Attributes adia List:
Change Priority ta: f EEEEEQH
2 v_ / COROM
If SCP (DVD or DLT), cannct ] Disable limit Sheeking el
change madia type; update I:l Ch XML OD"'L"-.._ / BE
SCP Parameters available (but Is Bige 10 i ) B
datesto DVD or OLT iy
no updatesto or | Update SCP Parameters T / Raqua“ Attributes
- s bt it —— z
IF NOT 8CP (but IS FtpPush, FtpRull ar Change Me o Change Priority to:
COROM) option available to change - .F B = I
media typa; no updats SCP (FtpPull or T ’ e
COROM) Parameters, can Update D Disable limit chacklng i I;riuri:yList:
FtpPush
ks [] Change XML to ODL Low.
: = High =
¥High
XPress

> Change Request Disposition: Click Fail Request option, then click Apply to commit changes.
ssFigure: Request Level Disposition
J Request Level Disposition |

(%) Keep on hald
' Bubmit
) Fail Reguest

) Partition [ Interval: dayis) and hiaurs ]

> Close the Close Interventions page, as appropriate by ente_rin%AdditionaI e-mail text, if sending
e-mail message to the requester or click Don" t send e-mail checkbox, then click OK.

> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.
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OM GUI

Request Management (cont.)

U Request Management — Open Interventions
s*Figure: Open Interventions Page

Open Interventions |

Current Filters

Order ID: Mone Request ID: Mone Worked By: Mone
Creation Time: Start: Jan 9 2007 10:424M End: Jan 10 2008 10:424M
Media Type: Explanation: ALL Explanation: ALl
Intervention Type: ALL
Options |
Change Filter 4' 4'
All Mane Al Mane

Click on a request 1D to view more detalls.

Listing
Go directly to row ok |of540 rous Show| 50 ¥ rows at a time.
first | previous | Showing 1 - 50 of 540 | next | last
Fﬂﬁesluh Order ID Request 1D MediaType g;:';:;l Status % Created | Acknowledged Explanation(s) IntervType
Failed transferring
[0 [ |2000013584(2000013940)  FtpPush 2 PENDING den ) 200 Reguest Canceled Operiitay
J16FPM . Intervention
Transfer failed
Ftp Login Errors
0 [ |2000013582 2000013938|  FtpPush 2| PENDING Jan 9 2008 Request Canceled Qi
12:14PM . Intervention
Transfer failed
FtpPush Directory does not
| Jan 9 2008 Jan 82003 A . L Operator
[0 [ |2000013577| 2000013933 FtpPush < .5 IN-WORK| amsadmin 11-2240 11-35AM Exist or No Write Perm|s§|on Intervention
Transfer failed
Dec 18 2007 ) Operator
[0 [0 |2000013586 2000013922 FtpPush 154/ PEMDING 12-48PM Request Resubmitted Intervention
Dec 18 2007 . . Media
] 2000013464 2000013820 DLT 11 PENDING 12-42PM Media Creation Stopped Creation Ertor
May 27 2007 Ftp Login Errors Operator
[0 [ | 2000013561 2000013917 FtpPush < 5| PENDING 1-98EM Transfor failed|  Intervention
.| Oct 18 2007 Oct 25 2007 Failed by Operator Operatar
[0 [ |2000013560| 2000013916 FtpPush = 5| IN-WORK| omsadmin A16PM 12050 M Transfer failed Intervention
Oct 18 2007 Failed transferring Operator
[0 [0 | 2000013555 2000013915 FtpPush < 5 PEMDING A11EM Transfer failed|  Intervention
O 2000009517 2000010152 ovD 154 PEMDING Qct 18 2007 Madia Creation Error Media

M
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OM GUI

Request Management (cont.)

U Request Management — Open Interventions
ssFigure: Interventions For Request <ID> Page

Interwention For Request 02000282129
Order |D: 0200083871 User 10: labuser (labusen@eos. hite. com)
Request |0: 0300052129 Crested; Apr A7 2007 11:0440
Input Size: 119 estimated MB Acknowledged:

hedia Type: sop Request Status: Operator Intervention
Friority: “HIGH Metadata Format: AML
Explanation|s]: Transfer failed

Worked by: - Mo woder 3ssigred - [ assign

Granule List

Go directhy to rav ok |of1 (=] Showl20 romes at a time.

first | previous | Shawing 1 - 1 of 1 | next | |ast
DFL IO s Explanation J
124256 Apply |‘ 157831 AST_L1B.002  SC 118.753 FAILED: sop Copy Serverisdown =

Narual fail eguind

anule

Select all I_

Submit Aclions |

first | prewious | Showing 1 - 1 of 1 | nexd | last |

Request Attributes
Change Priority to:

Request Lewvel Disposition

I ;I o Keep on hold
 submit
W Frss0e it dhasting uami
I_ « Fail Request
Change XML to ODL o

Fartition [ Intercal: dawis) and haurs]
Il_ Update SCP Parameters |_ |_

Operator Hotes
0 of 255 max characters

NOTE: Update FtpPush/SCP parameters option,
edits the existing FtpPush information when the
intervention is closed. Option appears on
confirmation page for FtpPush/SCP media types) Y | rese |
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OM GUI

Request Management (cont.)

0 Request Management — Completed Operator Actions and Interventions

» Displays all recently closed interventions, including those that have
been resubmitted, partitioned or failed. By default, the interventions are
filtered by “completion time,” within the last 24 hours.

» Operator defined filtered results displays on page as described

in this table: | - 2
- Filter - filter display

Options Fields
Intarvantion Type: Cirder id
_ _ oAl
*Hard Media actions OMona R t1d
Obsolete in Release 8.1 S
¥ Intervention Types :
=dytivare Media for GIC Usarih
A tivae Request "
"icemble Podiage Size (MB]
"Collect Media for GIC Madia
=Dismount Aedial from Production
"HEG Bror
=Media Credfion Emor Wotked By
=yount Medial for Production ;
i e Intervention Typa
"Opearator Inerwention
*0IC Failed Chagted
Worked By Completed
Completion Time: Disposition
OApply
OR& at
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OM GUI

Request Management (cont.)

0 Request Management — Completed Operator Actions and Interventions

» Procedure: Viewing/Filtering Completed Operator Actions and Interventions
> Click Request Management menu, then click submenu Completed Actions and Interventions.
ssFigure: Completed Operator Actions and Interventions (only two Interventions types exists)

Completed Operator Actions and Interventions |I

Filter

Intervention Type: Start Monith Start Day Start Year Start Hour Start Minute

Completion 01 21 v 2008 v 10 % 35 ¥
Time:

" End Morth  End Day End Year End Hour End Minute
REEREEI] LU s D v 22 v 2008 v 10 v 35 SRRl ]_lRESEt

Go directly to row ok |of0 rows Shaw | 50 ¥ roves at atime.

Wsrning: no roves to navigate!

first | previous | Showing 0 - 0 of O | next | last

Order Id | Request Id | User 1D | Size (MB) | Media Worked By Intervention Type | Created Completed Disposition
first | previous | Showing 0 - 0 of O | next | last

£ [

> Specify the Show <number>rows at a time display: Under Filter, select 20.

> To define the filter criteria: Under the Filter section, select one or more Intervention
Type; select an available User or All Users from the Worked By list box, then define the
Completion Time (the start to end times). Finally, click the Apply button to apply the filter.

» The Completed Operator Actions and Interventions page refreshes with the filtered results.

> To display detailed information of a request, click a Request Id <number> link in the
list to display the Completed Operator Action For Request <ID> page.

___________________________________________________________________________________________________________________________________________________________|
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OM GUI

Request Management (cont.) %

0 Request Management — Completed Operator Actions and Interventions

» Procedure: Viewing/Filtering Completed Operator Actions and Interventions

> To view Processing Instructions (details) related to a granule ID: Click the View... link,
under Processing Instructions column heading in the Granule List section

of page. Click the red-X close window text to return to the Completed Operator
Action For Request <ID> page.

s Figure: Completed Operator Action For Request <ID> Page

COMPLETED OPERATOR ACTION FOR REQUEST 0300004074
User ld: ECSGuest email: oladele_ocgunsuyi@raytheon.com  Priority: NORMAL
Order Id (:i"‘zBe) Media W(;’:ed Intervention Type Created Completed| Disposition Explanation
Activate Media for Apr 15 2005 Reqguest Wiaiting For device
1S00EESESI) 48| CoReM Qi 1:49F M Activated assignment
Granule List |
Go directly to row ok | of 2 rows | Show I 20 vl rows at a time |
first | previous | Showing 1 - 2 of 2 | next | last |
DBID ET?/E: Size (MB) Status Processing Instructions Explanation
21221 MOD13A2 004
DPL Granule ID: 1432 o 18.702 STAGED View...
21219 MOD13A2.004 H f
DPL Granule ID: 45 - 30368 STAGED View View... links to.the
first | previous | Showing 1- 2 of 2 | next | last granule processing
instructions window.

OPERATOR NOTES

> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.
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OM GUI

Request Management (cont.)

O Request Management — Distribution Requests [filter]

* The Distribution Request page allows Operators (either full-capability or
limited-capability) the ability to filter and view lists of all currently
distributed requests processed through Order Manager from all order
sources. The data distribution functions eligible on requests:

— Suspend new request processing.
— Suspend or cancel individual requests.
— Change the priority of any request.

* |n addition to these capabilities, the Operator can view extensive details of
FTP Push distribution and staging requests by selecting order id or
request id column links.

= OM GUI pages are tracked with a Session ID, which provides the Operator
guick access to filter options used during a particular session:

- For example, an individual Operator’ s previously defined filter criteria can be retrieved
from the Session data so the filter criteria do not have to be redefined every time.
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OM GUI

Request Management (cont.)

U Request Management — Distribution Requests [filter]

= Open Interventions Page has three working parts:
1 — Current Filter (Frame 1) — pre-defined filter criteria.

2 — Options (Frame 2) — change filter, bulk cancel, bulk claim, bulk resubmit.

» Bulk Cancel — Any Physical Media requests that are bulk cancelled, the media
volumes for these requests will be considered dismounted.

http:/ft4splol.hitc.com:22451 - Bulk Cancel Request - Mozilla Eiref E]@E]

sessionld=omsadmin

Confirm Bulk Cancel Action

Worker
|urnﬂdrrin
Reason for Action

o

Apply "Bulk Cancel” Cancel "Bulk Cancel”

<]

| Done

» Bulk Claim — Operator interventions can be bulk claimed using this button.
» Bulk Resubmit — Select All or No eligible requests for Bulk Cancel or Resubmit

3 — Listing (Frame 3) — captures requested distributions filtered output.
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OM GUI

Request Management (cont.)

U Request Management — Distribution Requests [filter]

» Procedure: Viewing/Filtering Distribution Requests Data
> Click Request Management menu, then click submenu Distribution Requests [filter].

> To perform a specific action (suspend, resume, cancel resubmit or stop a distribution request) on
a distribution request from the Actions column options, on the page:

> Click the appropriate Action button associated with the request (or the appropriate button
in the Action row on the Distribution Request Detail page), then click the applicable
response from the associated actions dialog box.

> To define the filter criteria: Under the Options section, click the Change Filter button to display
two filter criteria sections for Individual or Combined Filters. Then create a combined filter as
follows:

> Select a Start Time and End Time.

> Make multiple Status Select selections using the <Ctrl> key.

> Select All for Media Type Select.

> click Apply Combined Filters button.
» The Distribution Requests Filters window closes and displays the Distribution Requests results.
> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.
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OM GUI

Request Management (cont.)

U Request Management — Distribution Requests [filter]
ssFigure: Distribution Requests Page and Filter Window
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OM GUI

Request Management (cont.)

U Request Management — Distribution Requests [filter]
ssFigure: Distribution Requests Actions Response Dialog Boxes

[JavaScript Application]

i"_\ Buspend|Request 0400081320
L3

An intervention will be created

@ Are you sure you want to[create an intervention]
| and [submit|this Request 04000643227

Resubmit Dishibulion

Request dialog box _E)K Cancel I
ConfirmResumelfor || L =

Request ID 0400081320 | Netscape

_‘M:urker

Reason for Adion g e b ey Confirm _[g: I : !a; I for |
Request ID 0400081320

Worker

| Cancel Dishibvlion Request
Apply "Resume” Action| Cancel "Resume" Action | Reason for Action Confimation dialog box

[JavaScript Application]

Suspend Distibulion
Request dialog box

Apply "Cancel" Action| Cancel "Cancel" Action I
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OM GUI

Request Management (cont.)

U Request Management — Processing Service Requests [filter]

» The Processing Service Requests page allows Operators (either full-
capability or limited-capability) the ability to cancel or suspend the
external processing requests still under OMS control. However,
requests under the external system can not be canceled or suspended
by the Operator.

» Processing Services Filter includes options to filter on external
processing service (external subsetter requests). DataAccess
processing requests are viewed through the regular distribution request
screen with a filter (OrderType=DA).
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OM GUI

Request Management (cont.)

1 Request Management — Processing Service Requests [filter]

» Procedure: Filtering Processing Service Requests
> Click Request Management menu, then submenu Processing Service Requests [filter].
> To define a combined filter criteria:

> Under the Options section, click the Change Filter button to display the Processing
Service Requests Filters window.

> Under the Combined Filter section of the filter, select criteria:
« Request Creation Date (Start Time) = “01 01 2007
» Status Select = All button
* Media Type Select = All button

* Process Service Select = All button

> Click the Apply Combined Filters button, to apply the combined filter criteria and refresh the
Processing Service Requests page.

> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.
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OM GUI

Request Management (cont.)

1 Request Management — Processing Service Requests [filter]
ssFigure: Processing Services Requests Page (A) and Filter (B)
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OM GUI

Request Management (cont.)

O Request Management — FtpPush/SCP (or Staging) Requests [filter] Page

» Distribution filters allow Operators (either FC or LC) to view extensive
details of FtpPush/SCP and/or Staging distribution requests currently
processed through Order Manager (from all order sources).

» FtpPush/SCP and Staging distribution requests pages allows
the Operator to set the priority of (or suspend) a distribution request
while:
- Change requested granules are in a staged (or pushed) waiting state.

- Resume a request that was suspended by the OM GUI Operator or while the
processing of new requests by the OMS is suspended.

- Resubmitting a request in a terminal state (e.g., aborted, cancelled, terminated,
or shipped).

- Canceling a request that is not in a terminal state and while the requested
granules are in a staged (or pushed) waiting state.

___________________________________________________________________________________________________________________________________________________________|
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OM GUI

Request Management (cont.)

O Request Management — FtpPush/SCP (or Staging) Requests [filter] Page

» Procedure: Filtering FtpPush/SCP (or Staging) Requests

> Click Request Management menu, then submenu FtpPush/SCP Requests [filter]
(or submenu Staging Distribution Requests [filter]) to display its page.

s Figure: FtpPush/SCP Requests _
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OM GUI

Request Management (cont.)

O Request Management — FtpPush/SCP (or Staging) Requests [filter] Page

» Procedure: Filtering FtpPush/SCP (or Staging) Requests (cont.)

> To define a combined filter criteria: Under the Options section of the FtpPush/SCP
(or Staging) Distribution Requests page, click the Change Filter button to display the
distribution requests filter.

ssFigure: FtpPush/SCP (A) and Staging (B) Distribution Requests Filters.
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OM GUI

Request Management (cont.)

O Request Management — FtpPush/SCP (or Staging) Requests [filter] Page
» Procedure: Filtering FtpPush/SCP (or Staging) Requests (cont.)

> Under the Combined Filter section of the filter, select criteria:
« Request Creation Date (Start Time) = “01 01 2007”
» Status Select = All button
» Media Type Select = All button

* Order Type Select (for Staging) = All button.

> Click the Apply Combined Filters button, to apply the combined filter criteria and
close the FtpPush/SCP (or Staging) Distribution Requests Filters window. The
FtpPush/SCP (or Staging) Distribution Requests Filters page displays with the
applied combined filter results.

> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.
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OM GUI

Request Management (cont.)

1 Request Management — Operator Alerts

» The Operator Alerts page displays informative non-fatal warnings or
distribution resources errors and will not cause an Operator intervention.

= Alerts clears automatically once error is corrected.

» Operators (both FC or LC) can view three alert types detected by the
Order Manager Server:

1 — FtpPush/SCP Destination Alerts are alerts for destination problems not sufficient
to cause an Operator intervention (i.e., suspended FtpPush/SCP destination).

2 — Data Pool File System Alerts generates warnings regarding malfunctions of the
DPL file system (i.e., server down, no free space).

3 — ECS Server Alerts (AIM database errors warnings) detects warnings regarding the
AIM malfunctions or OMS resources (i.e., server down).

» The Alerts page has two display parts:
1 — Show <number> rows at a time displays limited records (5 to 100) on page.
2 — Display <list> alerts displays alerts type by group.
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OM GUI

Request Management (cont.)

1 Request Management — Operator Alerts

» Procedure: Handling Operator Alerts
> Click Request Management menu, then submenu Operator Alerts to display its page.
ssFigure: Operator Alerts Page (A) and Alert Details Page (B-C)
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OM GUI

Request Management (cont.)

1 Request Management — Operator Alerts

» Procedure: Handling Operator Alerts (cont.)

> To view email parameters configuration (located at left-bottom of page): Click [Change] link to
display the OMS Server and database Configuration: Email parameters page. After viewing, click
the Previous Page (<) button to return to the Operator Alerts page.

ssFigure: Operator Alerts Page Table (Fields and Options)
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OM GUI

Request Management (cont.)

1 Request Management — Operator Alerts

» Procedure: Handling Operator Alerts (cont.)

> To view all FtpPush requests: Under the Listing section header, select FtpPush from Display
<list> alerts list box.

> View the displayed FtpPush listing.

> To display extended details affecting the request, select details... associated with the request
under the Alert Info column.

> Return to the Order Manager Home page, on left-pane of OM GUI, click the HOME link.
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Order Manager GUI

Destination Monitor

d OM GUI — DESTINATION MONITOR

» The full-capability Operator is provided monitoring capability to
suspend distributions.

= OM Destination Monitor submenu:
— Suspended Destinations.

______________________________________________________________________________________________________________________________________________________|
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OM GUI

Destination Monitor (cont.)

O Destination Monitor — Suspended Destinations

= Full-capability Operator views suspended FtpPush/SCP destinations and
can perform several kinds of actions, with respect to suspended
FtpPush/SCP destinations from the Suspended Destinations page:

— Resume suspended destinations.
— Suspend active destinations.
— View details of active or suspended destinations.

— In addition, the Operator can perform destination details page actions:

— Change the priority of a distribution request associated with the FtpPush destination
while granules for the request still need to be staged or while granules for the
request still need to be pushed.

— Suspend a request that still needs to be staged or while granules for the request still
need to be pushed.

— Resume a request that was susEended by the OM GUI operator or while the
processing of new requests by the OMS is suspended.

— Cancel a request that is not in a terminal state and while granules for the request still
need to be staged or while granules for the request still need to be pushed.

= The limited-capability Operator is not allowed to change the priority of,
suspend, resume, cancel or resubmit distribution requests.
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OM GUI

Destination Monitor (cont.)

O Destination Monitor — Suspended Destinations

» Procedure: Viewing/Responding to Suspended FtpPush Distribution
Destinations
> Click Destination Monitor menu, then click submenu Suspended Destinations.

> Toresume a suspended destination: Click the Resume button under Resume column (if
applicable).

» The destination is resumed and the Suspended Destinations page list refreshes.

> To suspend an active destination or view destination details of an active or suspended
destination: Enter Destination Name or Host Name (FTP Node) in text fields under Active
Destinations section, then click applicable button (Suspend or View Requests).

* NOTE: Data in the FtpPush Requests List For this Destination section are not in a “terminal” state.

> To view suspended destinations details: Click the Host Name link on the Suspended
Destination Monitor.

» The list of failed destination requests displays in the FtpPush Monitor page.
> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.

|
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OM GUI

Destination Monitor (cont.)

O Destination Monitor — Suspended Destinations

ssFigure: Suspended Destinations Monitor (A) and Ftp Push Monitor-Suspended
Configured Destination (B) Pages
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Order Manager GUI

Archive Data

d OM GUI — ARCHIVE DATA

» The Operator (whether full-capability or limited capability) is provided
with the option of viewing the repository for all historical distributed
and processed requests on the OM GUI using filters.

= Archive Data submenus:

— Historical Distribution Requests [filter].
— Historical Processing Requests [filter].
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OM GUI

Archive Data (cont.)

4 Archive Data — Historical Distribution Requests Filter

» Provides atool to view, by filtering the repository of archived distributed
requests information on the OM GUI.

» Historical Distribution Requests Page has three working parts:
1 — Current Filter (Frame 1) — pre-defined filter criteria.
2 — Options (Frame 2) — features to change an individual or combined filter.
3 — Listing (Frame 3) — requested distribution filtered output.
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OM GUI

Archive Data (cont.)

=5

O Archive Data — Historical Distribution Requests Filter

= Procedure: Viewing Historical Distribution Requests
>  Click Archive Data menu, then click submenu Historical Distribution Requests [filter].
> Display data in a specific sort order: Click a specified underscored column header.

>  Display more detailed data concerning a particular order or request: Click the Order<ID> or
Request <ID> under the identifying column header.

>  Click the navigation Previous Page (<) button and return to the Historical Distribution
Requests [filter] page.

Figure: Historical Distribution Requests Page (A)
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OM GUI

Archive Data (cont.)

O Archive Data — Historical Distribution Requests Filter

» Procedure: Viewing Historical Distribution Requests (cont.)
> To apply a filter to the Historical Distribution Requests listing, perform the following:
> Click the Change Filter button, in the Options section of the page.
» The Historical Distribution Requests Filters window displays.

> Define filter criteria: Enter search data for any one field of the Individual Filter, then
select multiple options for one or more fields of the Combined Filter. Click the Apply
Combined Filter (or Apply Individual Filter) button to apply the filter criteria and view the
filtered results.

> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.
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OM GUI

Archive Data (cont.)

O Archive Data — Historical Processing Requests Filter

» Provides atool to identify and filter archived external processing
requests, by external subsetting processor on the OM GUI. Specific
external processing can be filtered.

» Historical Processing Requests Page has three working parts:

1 — Current Filter (Frame 1) — pre-defined filter criteria.
2 — Options (Frame 2) — features to change an individual or combined filter.
3 — Listing (Frame 3) — requested distribution filtered output.

Current Filters Options Listing
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OM GUI

Archive Data (cont.)

O Archive Data — Historical Processing Requests Filter

= Procedure: Viewing Historical Processing Requests
>  Click Archive Data menu, then submenu Historical Processing Requests [filter].
> Display data in a specific sort order: Click a specified underscored column header.

>  Display more detailed data concerning a particular order or request: Click the Order<ID> or
Request <ID> under the identifying column header.

>  Click the navigation Previous Page (<) button, to return to the Historical Processing
Requests [filter] page.

> To apply afilter to the Historical Processing Requests listing, perform the following:
> Click the Change Filter button, in the Options section of the page.
» The Historical Processing Requests Filters window displays.

> Define filter criteria: Enter search data for any one field of the Individual Filter, then select
multiple options for one or more fields of the Combined Filter. Click Apply Combined
Filter (or Apply Individual Filter) button to apply filter criteria and view the filtered
results.

> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.
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OM GUI

Archive Data (cont.)

ssFigure: Historical Processing Requests Page (A) and
Historical Processing Requests Filter (B)

O Archive Data — Historical Processing Requests Filter

B Historkcal Pracessing Requess Flltars
Individual Filters
Bl ooy won of e ingivicical iiery
Historical Processing Requests e et T = L
Current Filters ! ! !
Order ID: Hone Request I Nore E-Mail: Plone First Hame: Mone Last llame: Mone Frel Myr | Lesitlyrs _tew |
Creation Tine: Start: War 9 2005 05:329M End: Apr 17 2007 1005600 User W More
Options Combined Filters
Changa Filler ‘1 # Bequoat Crastion fate Fittera
Individual or o . e
Listing combinad fod Targ MO Doy Vear Howr e
I I filtari w1 W 2008 W T
Go disectiy to o ok [ of 14 rovs Showe 0 % rows at 2 tima. Clap ;Itlnl?lt_l,l'
first | previous | Showing 1 - Heflil.sﬂl.a.a L
= an | tene
Ordertd |Gum] R 'E!!!!Il Resub : —m—' “Ha
fannoenn | Frocessor Size(MB) Cnt Media uest ESDT Usenll " ot Craated Last Updat
0300076633 : ' Sep21 2006 | Sep21 200
0007 4955 Subsetter]| <.5 1 |FtpFush Shipped MCHDT1A7.004 | ECSGuest 1] 429PM 43P A . —
(300076626 Oiperatar Sep 21 206 | Sep2! 20 [ Faers
f00074pa7| CTHER | 6 10| EIRRE N erGrtion| ouALDOE | | ECSGUest ] H0 414PM 421PM | | |
s — ! S gty Cione
Q300076604 Sep 21 2006 | Sep21 20D Detachs Detacts Windew
Oa0007 48073 OTHER 1] 1 | FtpPull Aborted MO0 147 004 | ECSGuest (1] F16PM S 41PM
0300076558 Sep 21 2006 | Sep 21 2006
RETTIEI OTHER i} 1 | FtpPull Abort M0 141004 ECSGuest [1] 1970 1270
| Sep 142006 | Sep 14 2006
S| OTMER | <5 | 1 |FipPul | Canceled ]Mc-m 1A1.004| ECSGuest | 0 | SRI420 il
CE0007E202 : Sep 13 2006 Sep 13 2006
ETTYIN Subszetter] i} 1 | FtpPull | Teminaled | ECSGuest 1] 290Dk 24700
7 Operatar Sep 132006 | Sep 13 2006
FEnriTadiE | Subsetier]] <. 1 FpRul e iian !MW 1A1.004 |  ECSGuest o 2:32PM 24P
CE0007E1 25 Operator | Sep 13 2006 Sep 13 2006
FETTIEN Euhsallaﬁ| | 1 |FIpF‘u®h Imsr.untiup MO 141 004 | dd7 cBBsGa35ad] O | 2960 2900k
625-EED-004, Revision 03 55




Order Manager GUI

OM Status Pages

d OM GU — OM STATUS PAGES

» The Operator (full or limited capability) is provided summary information
on current requests processing states, with the option of invoking
gueries to view the statuses on the on the OM Status Pages. The status
pages parameters are modifiable using the OM Configuration
Server/Database submenu options.

= [NOTE: Use the Server/Database Configuration menu to set database and server
Wee "
parameters to fine tune” the Order Manager Server and the database. These are
general parameters that affect the entire system, but no particular media types.]

= OM Status Pages submenus:
— Staging Status:
* Media Type.
 FTP Push Destination.
o SCP Destination.
 DPL File System Status.
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OM GUI

OM Status Pages (cont.)

O OM Status Pages — Staging Status

» Full-capability Operator can monitor the number of granules and data
volume currently in staging states.
» Staging Status pages displays status in ALL or three ways:
1 — Media Type (Frames A).
2 — FTP Push Destination (Frames B).
3 — SCP Destination (Frames C).

» The granules staging information (Figure 15.9-3 Staging Status Pages
and Table (Fields) is arranged in four categories:

1 — Granules Waiting for Staging.

2 — Granules In Staging.

3 — Granules that have been Staged and NOT Shipped.

4 — Granules that have been Staged, Shipped and In DPL.
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OM GUI

OM Status Pages (cont.)

U OM Status Pages — Staging Status

» Procedure: Viewing Staging Status

> Click OM Status Pages menu, then click one of three staging statuses: Media Type, FTP Push
Destination or SCP Destination. To view another staging status page, select staging type
from the list box on the current page.

> Observe the information displayed under Granule Count and Volume section:

— Staging Status — page display information columns, except data is generated as media or
destination.

— The System Totals — the manually suspended queue by Operator (or if yellow, the
suspended queue is in progress).

— AutoRefresh — if ON, the Staging Status by <staging type> page refreshes automatically,
as often as specified in the Refresh screen every <number> minutes.

> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.
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OM GUI

OM Status Pages (cont.)

O OM Status Pages — Staging Status
s*Figure: Staging Status Pages an_q its Table (Fields)
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OM GUI

OM Status Pages (cont.)

1 OM Status Pages — DPL File System Status

» The Operator (full or limited capability) to view-only ongoing activities of
the DPL File System Status in two categories:
1 — Data Pool File Systems.
2 — Archive File Systems.

» Procedure: Viewing Data Pool File System Status
> Click OM Status Pages menu, then click submenu DPL File System Status to display its page.
+ Figure: DPL File System Status Page

Read-Cnly view i Fi
Data Pool File Sy
Nome  Sws FeeSpace USSP GacheUsed Alen ' Queued
A @] wes | S w8 |
Ff;: DEVIS\neTS2 . E] i . 205 GB Fa 4"’?& 22 | 2% | 0. O_ s ] 5:03 Mg |
Archive File Systems
| | | 1 |
AMPS1 [ 620m cmf| 95% e |
| ). | i | |
?R{_}_M§, :@--:--4 199 GB | fe --z;ﬁc;.»--.l 958 |
i I £ IS 1R 2%| 95% 100% |

> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.
I ——
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Order Manager GUI

OM Configuration

4 OM GUI — OM CONFIGURATION

» The Operator (FC) is allowed to configure aging rules for each priority
level — Aging Parameter; to set database and server parameters, which
affect the entire system — Server/Database Configuration; and to set and
adjust media types attributes — Media Configuration.

= The Operator (LC) can view the values assigned to OM Configuration
Parameters, but is not allowed to change any parameter values.

= Users can perform validity tests against received granules using
checksum validation on OMS distributed files.

= OM Configuration submenus:
— Aging Parameters.
— Server/Database:
* [All] [queue], [cleanup], [emalil], [media], [staging], [partition], [misc].
— Media
— ODL Metadata Users
— Checksum Users
— External Processing
— FtpPush/SCP Policy
— DataAccess Processing

625-EED-004, Revision 03 61



OM GUI

OM Configuration (cont.)

1 OM Configuration — Aging Parameters

= Aging parameters affect how distribution requests are aged over time.
The Operator (FC) has the option to configure aging parameters (rules)
for each priority level using the Aging Parameters Configuration page.

= There are three types of aging parameters, however only two are
configurable for each ECS Priority Level (i.e., XPRESS, VHIGH, HIGH,
NORMAL or LOW):

1 — Age Step is the aging rate (0-255, including decimal fractions) by which the
requests effective priority increases at hourly intervals, but not to exceed the
“Maximum Priority”. If the parameter is set to zero, waiting requests priority never
increases. For examﬁle, if the Age Step = 5.5 with an initial priority = 100, waits 10
hours to be pushed, then the request’ s priority increases by 5.5 hourly until delivery:

Hour O:priority = 10
Hour 1:priority = 105.5
Hour 2:priority = 111

Hour 10:priority = 155.
2 — Maximum Priority is a request’ s maximum priority attained in aging process.
3 — Starting Priority is a non-configurable arbitrary value representing the priority.
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OM Configuration (cont.)

O OM Configuration — Aging Parameters
» Procedure: Checking/Modifying Assigned Values of Aging Parameters

> Click OM Configuration menu, then submenu Aging Parameter Configuration
Aging Parameters to display the Aging XPRESS
Parameters Configuration page. Age Step” T
s*Figure: Aging Parameters Page Maximum Priority © pss
> To modify (as authorized) aging parameter Starting Priority * 255
value(s): type new value(s) in relevant THIGH
parameter(s) text entry box(es), then click A9 Sten 1
Apply button (or Reset button to clear new Malon e MO8 P Sl
value(s) and retain original value(s). Stefng Eiky 2% “Starting Priority” valus:
HIGH “XPRESS = 255
> Return to the Order Manager Home page, Age Step T VHIGH = 25
on left-pane of OM GUI, click the HOME link. Maximai Biatity B Ryl
Starting Priority 220 “EOM:E0
HORMAL
Age Step pi
Maximum Priority hso
Starting Prionty 150
LOW
Age Step v
Maximum Priority T
Starting Prionty 60
Apply | Reset |
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OM GUI

OM Configuration (cont.)

O OM Configuration — Server/Database (Parameters)

» The OMS Server and Database Configuration page provides the full-
capability Operator (limited-capability Operator has limited options) with
options to check and modify OMS server or database parameters values.
These parameters affect the functionality of the OM server and database.

» Parameters are dynamically loaded from the OMS database into the OM
GUI configuration pages. If a configuration parameter is deleted from the
database, it is no longer displayed on the OM GUI - parameters displayed
on the OM GUI are variable.

» OMS Server and Database Configuration Parameters page has four
displays:
1 — Parameter.
2 — Description.
3 — Units.
4 — Value.
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OM Configuration (cont.)

O OM Configuration — Server/Database (Parameters)
s*Figure: OMS Server and Database Configuration Parameters Types and Names
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OM GUI

OM Configuration (cont.)

O OM Configuration — Server/Database (Parameters)

» Procedure: Checking/Modifying Assigned Values of OMS Server and
Database Parameters

> Click OM Configuration menu, then submenu [All] under the Server/Database header to
display the OMS Server and Database Configuration: All parameters page. NOTE: This page
displays all categories of parameters listed on the under the Server/Database submenu:

* [All], [queue parms], [cleanup parms], [email parms], [media parms],
[staging parms], [partition parms], [misc. parms].

> To modified (as authorized) server or database parameter value(s): Type the new value(s) in
the text entry box(es) for the relevant parameter(s), noting that the new value cannot be 0. Then
click the Apply button (or the Reset button to retain the original value).

* The OMS Server and Database Configuration page refreshes and displays new value(s).
> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.
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OM Configuration (cont.)

O OM Configuration — Server/Database (Parameters)
s*Figure: OMS Server and Database Configuration [All] parameters Page
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OM GUI

OM Configuration (cont.)

O OM Configuration — Media

» The Media Configuration page provides the full-capability Operator the
ability to check and modify media parameters.

» Media parameters, specific to distribution medium type, affects the
limit checking against standard media capacity and the partitioning
of requests.

» The Media Configuration page has two display parts:
1 — Parameter Name — label or title of parameter for each media type:
o FtpPull
+ FtpPush [— Dsyiuien
* SCp.
2 — Value — parameter size or limit.
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OM GUI

OM Configuration (cont.)

O OM Configuration — Media

» Procedure: Checking/Modifying Assigned Values of Media Parameters
> Click OM Configuration menu, then submenu Media to display the Media Configuration page.
s*Figure: Media Configuration Page

Media Configuration
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OM GUI

OM Configuration (cont.)

1 OM Configuration — Media

» Procedure: Checking/Modifying Assigned Values of Media Parameters (cont.)
> Observe information on the Media Configuration page, specifically the parameter types:

* MediaCapacity (GB) — initially set to the maximum capacity (in GB) for the type of media,
but should adjusted later to a lower or higher value, depending on data compression usage.

« PartitionGranuleLimit — the maximum number of granules that may be partitioned for the
type of medium.

« PartitionSizeLimit (GB) — the size (in GB) at which point partitioning of a request can occur.

 MinDaysBetweenChecksum — the number days, post-verification of checksum, as defined
by Operator, in which the checksum process is verified again.

 MinRequestSize (GB) — the minimum number of gigabytes that can be requested for the
type of medium.

 MaxRequestSize (GB) — the maximum total number (GB) that can be requested for that type
of medium, regardless of whether or not it can be partitioned.

* MinBundleSize (GB) — the minimum number of gigabytes in a bundle for the type of media.
» FtpPull (exclusive):
— Request High Water Mark — the RHWM is the desired maximum number of requests

that may be in the Staging state, or that have completed Staging but are not yet in a
terminal state (e.g., Shipped).
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OM GUI

OM Configuration (cont.)

1 OM Configuration — Media

» Procedure: Checking/Modifying Assigned Values of Media Parameters (cont.)

— Data High Water Mark (MB) — the DHWM is the maximum volume of data in staging or
already staged but not yet shipped. If the data volume and number of requests is above the
DHWM, it is assumed the media devices have plenty of work to keep them busy.

— Pull Gran Dpl Time (days) [...] — the number of days a granule for an FtpPull request would
normally remain in the Data Pool.

— Pull Gran Dpl Ret Pri (number) [...] — the normal retention priority for a granule for an
FtpPull request.

— Min Pri To Preempt (number) [...] — applies to granules put in the Data Pool for an FtpPull
request.

> To change the media parameter value(s): Type new value(s) in the text entry box(es) for the

relevant parameter(s), then click the Apply button to submit (or the Reset button to retain the
original values).

> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.
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OM GUI

OM Configuration (cont.)

1 OM Configuration — ODL Metadata Users

» The ODL Metadata Files Users Configuration page allows the full-
capability Operator to configure a list of Email addresses that signifies
users that need to receive metadata in ODL.met file format.

» Limited-capability Operator can only view Metadata File Users
configurations.

= The metadata will be distributed whenever the email address contains a
Distribution Notice.
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OM GUI

OM Configuration (cont.)

1 OM Configuration — ODL Metadata Users

* Procedure: Adding/Deleting User Email Address that will Receive ODL

Metadata File
> Click OM Configuration menu, then submenu ODL metadata Users to display the ODL
Metadata File Users Configuration page.

s*Figure: ODL Metadata File Users Configuration Page.
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OM Configuration (cont.)

1 OM Configuration — ODL Metadata Users

* Procedure: Adding/Deleting User Email Address that will Receive ODL
Metadata File (cont.)

> To Add User Email Address(es) to the ODL Metadata File Users Configuration: enter the new
User’ s email address in the textbox (at page bottom), the click the Add New User button. The
prompt indicating “A new user has been added....” appears, click the OK button.

> To Delete User Email Address(es) from the ODL Metadata File Users Configuration: Click one or
more Del checkboxes (or Select all) next to the User(s) to be deleted, then click the Apply

Deletion link. The prompt indicating, “...Delete the selected users?” appears, click the OK
button (or Cancel to discard changes)

> Return to the Order Manager Home page: on left-pane of OM GUI click the HOME link.
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OM Configuration (cont.)

O OM Configuration — Checksum Users
» A checksum is a computed value associated with a file, which can be
used to verify data validity on files distributed by OMS:
- Data validity tests can be performed against granule files.
- LC-Operator can only view Checksum Users configuration.
- Adding or deleting email addresses is not permitted by Operator.

= The full-capability Operator can configure a list of email addresses of
users to receive a checksum in the form of a request.
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OM GUI

OM Configuration (cont.)

O OM Configuration — Checksum Users
» Procedure: Adding/Deleting User Email Address that will Receive

Checksum File

> Click OM Configuration menu, then submenu Checksum Users to display the Checksum
Notification Users Configuration page.

s*Figure: Checksum Notification Users Configuration Page (Frame A).

Checksum Notification Users Configuration
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OM GUI

OM Configuration (cont.)

O OM Configuration — Checksum Users

» Procedure: Adding/Deleting User Email Address that will Receive
Checksum File (cont.)
> To Add User Email Address(es) to the Checksum Notification Users Configuration: enter the new

User’ s email address in the textbox (at page bottom; Frame B), the click the Add New User
button (Frame B). The new user has been added to the configuration page.

> To Delete User Email Address(es) from the Checksum Notification Users Configuration: Click
one or more Del checkboxes (or Select all) next to the User(s) to be deleted, then click the Apply
Deletion link (Frame C). The User’ s email address is removed from the configuration page.

> Return to the Order Manager Home page: on left-pane of OM GUI click the HOME link.
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OM Configuration (cont.)

O OM Configuration — External Processing

» The External Processing Configuration page allows the full-capability
Operator to define and configure the parameters of an external
processing service as follows:

- View the external processing services parameters.
- Delete external processing service with no pending requests.
- Add new external processing service.
- Edit existing processing service configuration.
» The full-capability Operator is limited view-only External Processing
Configurations.
» External Processing Services parameters descriptive listing:
- External Processor Service Name is a unique name for the service.
- End Point URL is the host URL address configured in the ECS registry.
- DN Email Address is the DN email address used by the external processing service.
- Total Requests Queued — is the total number of queued requests.
- Total Granules Queued — is the total number of queued granules.
- Request Acceptance — the acceptance of the request.
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OM Configuration (cont.)

O OM Configuration — External Processing

» Procedure: Checking/Modifying External Processing Services
Configurations

> Click OM Configuration menu, then submenu External Processing to display the External
Processing Services Policy Configuration page.

s*Figure: External Processing Services Policy Configuration Page.
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OM GUI

OM Configuration (cont.)

O OM Configuration — External Processing

» Procedure: Checking/Modifying External Processing Services
Configurations (cont.)
> To Add a New External Processing Service: Select the Add a New External Processing

Service button (or if editing, the edit button to the associated processing service), click Save to
submit the input, then click Done to return to the previous page.

> To Delete an External Processing Service: Select the checkbox(es) of the External Processing
Service, click the Delete Selected Processors button (at bottom of page), then click the OK
button to confirm deletion (or Cancel to discard the action).

> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.
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OM Configuration (cont.)

1 OM Configuration — Data-Access Processing

» Provides the full-capability Operator the ability to define, configure and
fine-tune parameter values of Data-Access services. Itis designed to be
easily configurable and extendable.

» Configuration parameters on the Data Access Services Configuration
Page has six working parts:
1 — Services
2 — Endpoint
3 — Max Jobs
4 — Timeout

5 —-Max Errors
6 — Retry Interval

Also:
7 — Update options to “Delete” or “Add service
8 — Acrive indicator is non-configurable
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=5

OM Configuration (cont.)

1 OM Configuration — Data-Access Processing

* Procedure: Viewing Data Access Services Configuration

> Click OM Configuration menu, then submenu Data-Access Processing to display the Data
Access Services Configuration page.

ssFigure: Data Access Services Configuration Page

T ﬁl Fri Apr 6 14:28.22 2012
Order Manager GUI |

Data Access Services Configuration

Data Access Services
Service Endpoint Max Jobs Timeout Max Errors Retry Interval Update Active
HEG http:/f4hel01:22500/HegSerice_TS2 7 1 1 1 Delete |
GDAL http:/fdhel01:22500/GdalService_TS2 5 1 1 1 Delete |
— | aw]

Need help with the Order Manager? Click on a Question Mark to get context-sensitive Help!
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OM Configuration (cont.)

1 OM Configuration — Data-Access Processing

* Procedure: Adding New Data Access Services Configuration

> To add a new service, click input box labeled, ‘Services’ and type service name, then tab to
next input box.

> To enter remaining data for the service, type info in box:
» Enter Endpoint URL of the service
« Enter Max Jobs allowed
» Enter Timeouts (seconds) for communications between the configured service and OMS
» Enter Max Errors allowable
» Enter Retry Intervals to the maximum number to retry requests sent to the service
> Click the Add button to Update and load the new service.
> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.
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OM Configuration (cont.)

O OM Configuration — FtpPush/SCP Policy

» Provides the full-capability Operator the ability to define, configure and
fine-tune parameter values of FtpPush/SCP destinations.

= Configuration parameters on the FtpPush/SCP Policy Configuration Page

has three working parts:

1 — Global Settings for All Destinations are
parameters that apply to all destinations
(both frequently used and non-configured),
regardless of their individual settings.

Global Settings
for Al
Destinations®

Figlds

Settings for Non-Configured

Destinations [Only apply to
FtpPush destination]

Fields

3
Frequently

Used
Destinations

Fialds

2 — Non-Configured Destinations are

FtpPush Max
Oparations

FtpPush destinations not specifically

Max. FTF Failures

defined as Frequently Used Destinations,

SCP Max
Operations

but use the parameter values in the

Max. SCPFailures

Settings for Non-Configured Destinations

Options

area.

Apply

Rasat

3 — Frequently Used Destinations are

FtpPush destinations that are non-configured.

s Figure: FtpPush/SCP Policy Destination
Table (Fields)

Retry Moda:
OAutomatic

OManual

Time Cut

Min. Throughput

Max. Oparations

Retry Intarval

Options

Apply

Resat

Dastination Name
(Alias)

Deal

Madia Typa:
OFtpFiEh
OsCcP

Host Addrass

Dastination
Directony

Ratry Modse

Options

Add a Destination

Dalata Salectad
Destinations

Salect all (Dal)
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OM GUI

OM Configuration (cont.)

O OM Configuration — FtpPush/SCP Policy

» Procedure: Viewing/Modifying FtpPush/SCP Policy Configuration

> Click OM Configuration menu, then submenu FtpPush/SCP Policy to display the
FtpPUSh/SCP P0|I0y Ord.rll Gul [_ I: ME:C;B °.f°;§";
Conflgurat|0n page A FtpPuéhlSCP PoI|cyCoanurat|on|

ssFigure: FtpPush/SCP Policy e i frm——
Configuration Page (A), Add e — | ——
Destination (B), Delete —— 1
Destination (C) and e — S—
Destination Details (D) T

Nams (Alias) Dl Media Typs| Host Address | Ditsctory Retiy Mode
1 nn Details link |CJ|FigPush | oigin hite.com idewdatal DEVD1Pusharea [sutomatic -~
2 nopape1"™™e 01 |5 kpush | eii hite.com IdatopoollOPSusentF S2/dpadintegration |[manual v |
3 OMSCP Distribution Aseal | O] sep. pOicy pre.ocs nosa.gov | AL0_buerfOPSAmpfestiéral
4 OMSCP Disiribution Asea2 | [ scp. Picgd1 puc.ecs. nasa.gov | AL0_bufler/OPSAmphestiArea2 Manual
5 OriginTempFipPush [ | FtpPush arigin /home/cmshared/TempFtpPush automatic ¥
B Add New Destination prush | 4001 | Mome/jnjangalFtpPushD automatic
T bPush | @01 omafinianaa/FtoPushE D
F T bPush | et FTPPushSCP Destlnatlon Details|
Target Diractary: [ id pPush  |f4spi)1 Destination Dutalls
HosthP Addeess: [ Mame (Aliask OM SCP Distribation Areat *
Media Type, FtpPush v AL B Target Diwctory: FLD_bulscOPSAmgtestiivest
Sonings for this Desiination wmwmmm { Fip pPush | Mspi1 HosP Adsess: | el pec cs nasa gy *
Max. Operations: B SCP Tie Cut 00 * bPush | Wspi0l b Tipe| scp
, Settings for his Destinstion
Dmu;:ml [N _ Mn:mw oo bpush 4501 frops— — T Ol
st L= siryieda) Aucomatic 1B bPush | idspi0l Disoble Checksnc] Ho % P i
. b 01 Retry Intorvat|[1 T Rviry Mede| Autornatic
0 o266 Wex, charac L Manual 2L =t ]
bPush #dspi01 1 of 265 Max. characters.
The page at http://f4om|01_hitc.com: 22401 says: )
® S | Ram
no ] (2) e o f e e | T
T 20 sep origin ol 3
- 21 5D | | finjangafEicpD [sutomatic +
\\._ & segkE TR TSRO T ey automatic ¥
i ested 1 ] Selectall -

® Tha “Add New Dastinsatior™ and the “F TPPus nracp‘
Dostination Details” pages display identical fialds,
althou, ghth ir functions serves two differant
purposes (frames B and D).

625-EED-004, Revision 03 85



OM GUI

OM Configuration (cont.)

O OM Configuration — FtpPush/SCP Policy
* Procedure: Viewing/Modifying FtpPush/SCP Policy Configuration (cont.)

> To view details of a destination, click the underscored Destination Name (Alias) and the
FTPPush/SCP Destination Details page (Figure D) displays. View detailed information on
page and click the Done button to close without saving any possible changes.

> To Disable Checksum, select Yes from the drop-down list of the checksum listbox.

> To Delete (remove) destination(s) from the Frequently Used Destinations sections: Click
the Del checkbox of corresponding destination(s), then click the Delete Selected Destinations
link (at bottom of section). At the confirmation prompt dialog box (Figure C), click OK to
confirm deletion(s) and move the destination(s) to the non-configured group (and erase its
parameter values).

> To Add a new destination to the Frequently Used Destinations sections: Click the Add New
Destination button to display the Add New Destination window (Figure B), enter values/data to
fields/parameters, then click the Save button to submit and to refresh the FTP Push/SCP Policy
Configuration page (Figure A).

> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.

___________________________________________________________________________________________________________________________________________________________|
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Help

d OM GUI — HELP

» There are two Help submenu options:

About HelpOnDemand... which features context-sensitive help for each page,
especially for non-descriptive controls or parameters.

Help which features text on various OM GUI related topics.
% Figure: Help (A) and HelpOnDemand (B)

= Active search functions® e St Maroge G ey

Hew 1o the OMS GUI? Below are some guidelines on how 1o use this mterface. For complate docementation, see the DID 609 document included with the installation package for this

using the current web

Search tip: Having troubfe finding a topic or keyword? Use your Browser's seanch function! In Netscape, select Edit > “Find in Page.. " from the menu or press Ctid + F {or AR » F in soma

b rowser IS al SO IL:':::Ss:-Io soarch for text withan this page B
aval | ab I e O n p ag eS [_..mx e Ontr Mo Pt The page at http://f4spl01.hitc.com: 22491 says:

1 Managemant

- - Requast Managemgnt
\ fe that ke for
within the GUI Qickinkste | » oy i lanenton Poge B h o e R T e

topic on Help » OM Confiquration will pop up.
paga. * DM Server Statrstics

LWhnt is the Order Manager GUI?
The Oder Manager GUI is a graphecal nterface that allows a DAAC operator to manage distrbution requests made through vanous order sowces. It allows: the operator to create
“mterventions” on requests which contain problams, causing the ordess to be unfulfillabla. Examples of such problems would be inaccessible granules, request size too lage, granule tod
large far the paricular media type. el The cperator can then make a disposdian on the eniere request and can even odit or fad particular granules asscoiated with that request

In addtion_ the cperater may wew detailed information on created imterventions, distibution requests, and ECS crders, amaeng ather things. Slaging queue state can also be monfared, and
the cperator can changs the siate of processing queues by media type or all medsa types simultaneously

The operatar may alse configure the Order Manager Database and Sener through this GUI. See M#Mfm"’_. Context-sensitive
links on Halp

topic within paga.

Do | nead to use a particular browser?
Yes. but you have chesces. Any Mozilla 5.0 based browser can be used with the OMS GUI That is bacause the OMS GLUI was built using the DOM standard cumently supported in the
Mazilla 5.0 specification. Mozilla 5 0-based browsers ane

+ Netscape T of hagher
# Firefox 0.9 or highar
+ Generic “Mozilla™ browsess for Linux or UNIX

W reccomad against wsing MS Infemet Explarer due 1o possible DOM conficts and differences in the JavaScrpt campiles

& s
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View Order Status

d OM GUI — View Order Status

» The OM GUI Order Status page allows the Operators (Full or Limited-
capability) the ability to monitor and/or view the status of orders
submitted via the OM GUI.

» The Operator can view detailed information in three status levels:

— Order Status
— Request Status
— Granule Status.

Get Order Status e

- Vi eW Ord er Statu S S u b m en u : Enter the Order |D| Get currant status of
— OM GUI Order Sta‘tus ,'. GetOrderSiatus | R ,m currant orders,
L Ty zlll | |

° H .
s Figure: Get Order
St t P ¢ Toget an order history (a listing of past orders with status), select either the number of
atus ag e Generatas saarch days fo look back {from today) OR select the date range

jof currant or
historical status) . NOTE: Usa amail Id associated with ordar. I_
on spacified fiald Enter The Email Id —7
antry. h
i
v Mumber of Days b
[ i Gat historical status
i - 0OR -- >-— of past andior

1 s completed ordars.
* BeginingDate | (MM/DDAYYYY)
" EndDate | (MMDDAYYYY) |

® GetRangeofOrderStatus | Reset _J

Claars entryfialds.
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View Order Status (cont.)

1 View Order Status — OM GUI Order Status

» Provides a visual display of viewing multiple levels of a particular order
status

» The Operator can search through to the lower levels of the order, the
status path is capture as a navigation bar.

2 Figure: Get Order Status A\ STATUS FOR ORDERID:<Order D>

Pages Navigation Bars | Sesrcr tor stars>>Order Status |
and FleldS A1 -AZ: Btatus pages
A ORDERID:<OrdeilD> STAUS: <status> COMPLETIONTIME: Navigation Bars {at top-
laft of status paga).

Sasrch for Status >>Order Status >>>Request Status

AS ORDERID: < OrderlD:> REQUESTID: < RequestiD > REQUESTSTATUS: <StatusType> MEDIA: <llediaType>> COMPLETIOHTINE:

Search for Status >>Order Status »>>Reguest Status »==>Granule Status‘

1
. Order Status n Request Status E Granule Status

Fialds Figlds Fialds
Iltam Number Iltem Mumber ltam Number
Ordar (D RaquastiD Granulald
Submitted Status ShortMame
Status Meadia YearsionlD
Complatad GranulaCount SizaMD
Associstad Request Completed Status
Associated Granules Procassing
Processing
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View Order Status (cont.)

1 View Order Status — OM GUI Order Status

* Procedure: Viewing Distribution Requests Order Status Pages

> Click View Order Status menu, then submenu OM GUI Order Status to display the Get Order
Status page.

> To retrieve a current order status: First, Enter the Order ID using a complete 10 digit order id.
Next, click GetOrderStatus button to retrieve the most current status and to display the STATUS

FOR ORDERID:<OrderID> page. QST A C
. . . R f Order List
> To retrieve the status of a historical*===* [Sse i su>>Order Status |
Order FIrSt, Enter the Em all ID S e ] O e e g e — ERROR (mare Error Details . )
address (id must be associategwith """ | e R
an historical order) and select(the - 2z R —
number of Number of Days fr th/-,% S—
list box — select 30. Or, enter a | STATUS FOR ORDERID:0300084004 I1B1
Valld range USIng the %;T;r?:m>>§ur::i::;us‘ Status |Completed |Associated Request i -
Beglnnlng Date (I\/I M/DD/YYY ) 1/0300084004 [Jul 20 2007 1216PM [Pending] 0300082263 The
and EndDate (MM/DD/YYYY) e i
text fields. Next, click the P— Drdackiss g conie \E’Q | The page at http://F4omi1.itc.con:22401... ()
Soerch for Stshs™>LN0RY S < | historical istarica 1 | Tnwald Range for the User En., Please Check
GetRangeofOrder Status button - ‘ ey
to retrieve the most current status  ces + wsssime —
and to display the Order LiSt PAJE § oueis . submited | siiseompleied Associaied Requssis
of related historical status(es). 1/0300083992  Jul 20 2007 114280 | Canceled | 0300082250
2] 0300083993 | Jul 20 2007 11:42AM | Canceled | | 0300082251 \
2 Figure- Order Status Pages 30300083991 | Jul 20 2007 11:42AM | Canceled | | 0300082252 \
) 410300083994 | Jul 20 2007 11:42AM | Canceled | 0300082253 \
(A-BZ) 5|usuonaas|95 Jul 20 2007 11:42AM | Canceled | | 0300082254 \
first | previous | Showing 1 - 5 of 47 | next | last \
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View Order Status (cont.)

1 View Order Status — OM GUI Order Status

» Procedure: Viewing Distribution Requests Order Status Pages (cont.)

> To retrieve the status of a current order detials: First, Enter the Order ID 10 digit order id from
the Get Order Status page (Figure A). Next, click GetOrderStatus button to retrieve the most
current status and to display the STATUS FOR ORDERID:<OrderID> page. Click the
Orderld<number> under the OrderID column to display the Listing details of the Request
Status (Frame C)

> To retrieve the Granule Status (Frame D): Click the RequestID<number> under the RequestID
column to display the details of the Granule Status.

> Using the navigation bar, click the Search for Status link to return to the Get Order Status page
(Frame A) and to perform other order status searches.

> Return to the Order Manager Home page, on left-pane of OM GUI click the HOME link.
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View Order Status (cont.)

1 View Order Status — OM GUI Order Status

» Procedure: Viewing Distribution Requests Order Status Pages (cont.)
ssFigure: Order Status Details Pages (A-D)
A

Get Order Status
|Ente< the Order D fo300084004 |
GetOrderStatus | Reset | B
STATUS FOR ORDERID:0300084004 |
Sesrch for Status>>Order Status
#[Orderld | Submitted |status |Completed |Associated Request
(e-C) ot Roquest ststws | 340300084004 [Jul 20 2007 12: 16PM |Pending| 0300082263
\ ORDERID:0300084004 STATUS:Pending COMPLETIONTIME:
earch for Status >>Ord w: »>>Req Status |

Listing |
Stow[E v rowsststime |

it | cemvian | Showing 11011 pat | st
# Roquestid| | | CTRRaECa i D AR G i
| | 124378 124379, 124380, 124351 124382.

124383, 124384, 124385, 124386, 124387,

124388, 124389, 124390, 124392, 124393,
Operator | | 124394, 124397, 124398, 124415, 124416,
(0300082263 i | COROM 41 124419, 124421, 124423 124425, 124427, N
| 124428, 124431, 124432 124434, 124435

124437, 124439, 124441 124443 124444
124445 124446, 124447 124448, 124449,
124450

frst | prbous | Showing 1-10f 1 next | ast | D

'ORDERID:0300084004 REQUE STID:0300082263 REQUESTSTATUS:Operator
T T _ intervention MEDIA:COROM COMPLETIONTIME:
| garch for Status >> ar Siatus 3

est Stawus >>>>Granule Status |

ion sg\ B 5 o :|’ Processi
10D |86 | 0.102077484130859 \STAGEG IN
g;mss& |MoD14 |BS |nss3a7508392334 \STAGED N

3124397 |MODW4 |86 |0.464058876037598 | STAGED N
4124398 |MOD14 86 |0 6037598 | STAGED |N
5124427 |MOD14 |86 | 0.68387508392334 | STAGED |N

first | previous | Showing 1 -5 of 41 | next | last
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Logs

d OM GUI - LOGS

» The OM GUI Log keeps record of every page run and every stored
procedure called within those pages.

» The log aid the System Administrator in problem resolution when errors
are encountered.

— EcOMGui.log is the log filename.

— The log file path is typically in directory [fusr/ecs/MODE/CUSTOM/WWW/OMS/cgi-
bin/logs] on the Data Pool Server host [x0dps01] where the OM GUI is installed.

* Logs submenu:
— OM GUI Log Viewer.

___________________________________________________________________________________________________________________________________________________________|
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OM GUI

Logs (cont.)

O Logs — OM GUI Log Viewer

» A convenient diagnostic tool that displays all current activity in the OM
GUI and allows the Operator the capability to view entries captured (from
page runs and stored procedures) in the log file.

» The log file that the log viewer displays is located under the [cgi-bin/logs]
directory where the OM GUI is installed:

— It is not the web server log or the SYSLOG.
— Itis a log [EcOmGui.log] that is specifically generated by and for the OM GUI.

» Procedure: Viewing the OM GUI Log

> Click Logs menu, then submenu OM GUI Log Viewer to display its page

> To view the log file: Enter 20 in the View the last line(s) of the log file textbox, then click
the OK button to generate a 20 page history.

* NOTE: The log viewer’ s functions similar to that of the UNIX “tail” command — the number of lines need to
be seen must be specified. Otherwise, if O is specified or left blank the entire log file will display.

> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.
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Logs (cont.)

O Logs — OM GUI Log Viewer
s Figure: OM GUI Log Viewer Page (A) and Log File Display (B)
OM GUI Log Viewer

A 3.300MB
33748 inas
Last modified on Sat Aor 8 13:18:16 2005

View the last 20 line(s) of the log file. oK |

Leave blank fo wew entire fog

B Viewing last 20 lines of the log file:

¥ showline numbers [lastline] |q— Linenumbers
digplay option.

33727:[Sat Apr 9 13:16:16 2005] EcOmCuiPmdictions.pl: Use of uninitialized vg
33728:[Sat Apr 9 13:16:16 2005] EcOmGuiPmdActions.pl: Use of uninitialized wvs
33729:#%% x#%x EcOmGuiPmdActicns: Input Parameters on Entry ##*
33730:autcRefresh => off

33731:refreshrate => 5

33732:sessionld => ralphadmin

33733:8at Apr 9 13:16:15 2005 There are NO selected action tvpes
33734:5at 2pr 9 13:16:15 2005 GetPhysicalMediaDataFromDB: sgl is

Displays last 20

el ooty ‘4 gg;g; DECLARE @Total_ Requests int
LR 33737: declare @total_output int
337138:
33739: EXEC OmGetMediadctionList
33740:
33741: @sortaction="DueDate",

33742:8Request_Id No = 1,

33743:@batchsize = 50,

33744:@8creen_Action = "C",

33745:eIntervent ionTypeList = "ALL",

\ 33746:4Total_Requests = @total_ocutput cutput
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Admin Tools

O OM GUI — Admin Tools

= The OM GUI Admin (Administrator) Tools page controls Operators’
profiles and configuration for every filed, on every page that is generated
within the OMS GUI.

= Admin Tools submenus:

— Server/Database Parameters — to check and modify server/database parameters
values.

— Media Parameters — to check and modify media parameters values.
— Aging Parameters — to configure aging parameters (rules) values.
— FtpPush Policy — to set permissions for FTP Push Policy Configuration Pages.

— Actions Pages — provides a set of predefined permissions to set, remove, suspend or
resume any/all related actions and/or related configurations on any/all related OM
GUI pages

» This page is restricted for use by the site Administrator only and will not
be trained.
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